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STIMA: MiIsURAZIONE
DI PARAMETRI METEO
E AMBIENTAL|

Tre nuovi moduli per l'acquisizione e
trasmissione al server RMAP dei parametri
rilevati, utilizzabili anche per applicazioni
domotiche come chiudere una tenda
da sole in caso di-pioggia.

di PAOLO PATRUNO
e DANIELE CASTELLARI

D opo avervi spiegato che cos’e il si-
stema modulare STIMA e come esso
si integra nel progetto RMAP (Rete di
Monitoraggio Ambientale Partecipativo),
in queste pagine presentiamo ulteriori
strumenti per acquisire parametri dall’am-
biente che ci circonda; abbiamo sviluppato
tre moduli con caratteristiche differenti che
si adattano a situazioni di installazione e di
utilizzo eterogenee per tipo di alimentazio-
ne e tipologia di comunicazione dei dati. I
moduli presentati in questa puntata sono
tre e vanno ad aggiungersi allo STIMA-
Bluetooth presentato nella scorsa puntata:
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LOCCORRENTE
PER LAPPLICAZIONE

B Microduino core+ 1284p 5V
H Microduino core+ 644p 5V
B Microduino-ENC

(RJ45 POE Included)
B Microduino ft232R
B Microduino-GPRS/GSM
B Microduino SDcard
B Microduino-nRF24
B board Stima Bluetooth
W board Stima I12C
m SET CAVI POE
W Display LCD 20x4 con interfaccia I12C
m MODULO 4 RELE 5VDC 10A
m MODULO 2 RELE 5 VDC 10A
B Modulo 1 relé 5 Vdc 10A

Stima-Master da collegare all’e-

thernet, Stima-Satellite collegabile
via radio al modulo Master, Stima-

GSM/GPRS che invia i dati su
GSM e salva i dati su SD-Card.
Il software che qui presentiamo
per la pubblicazione e visualiz-
zazione dei dati e utilizzabile su
differenti sistemi operativi: la

geolocalizzazione, autenticazione

e pubblicazione dei dati rilevati
manualmente o a vista e stata

testata su Linux, Windows, OS X e
Android. In parte, l'utilizzo e stato
spiegato nella scorsa puntata; in
queste pagine utilizzeremo I'ap-
plicazione grafica per la configura-
zione dei moduli STIMA, compre-
sa la geolocalizzazione, che e una
parte fondamentale.
Le configurazioni hardware sono
molteplici e utilizzano differenti
board; sono compatibili con i
moduli hardware maggiormente
diffusi e conosciuti dai maker e
generalmente a basso costo. Qui
utilizzeremo la configurazione
“impilabile” delle board Microdu-
ino. L'unico firmware sviluppato
si adatta all’hardware tramite il
preprocessore C; molte opzioni
quindi sono definite a tempo di
compilazione, mentre altre du-
rante 1'esecuzione e salvate sulla
EEPROM per poi essere rilette
all’avvio.

MQT1T

I'moduli STIMA che qui esami-
niamo utilizzano MQTT per pub-
blicare sul broker rmap.cc i propri
dati e metadati. MQTT (acronimo
di Message Queue Telemetry
Transport) & un protocollo pu-
blish/subscribe particolarmente
leggero, adatto per la comuni-
cazione M2M tra dispositivi con
poca memoria o potenza di cal-
colo e server (o message broker).
HTTP e il protocollo piu diffuso,
ma dal punto di vista dei device
che devono trasmettere dei dati,
pubd invece non essere la scelta
migliore: nell’ambito dell'Internet
of Things si stanno affermando
altri protocolli, soprattutto “bina-
ri”, che non solo hanno un pat-
tern diverso noto come publish/
subscribe, ma soprattutto garanti-
scono un trasferimento minimo di
byte “inutili” rispetto al contenu-
to informativo. Tra i piu noti c’e,
appunto, MQTT, nato proprio per
la “telemetria”, molto leggero ed
affidabile (garantisce tre livelli
differenti di QoS) soprattutto

su reti non perfette in termini di
stabilita della connessione.

Nello schema publish/subscribe,
mittenti e destinatari di messaggi
dialogano attraverso un interme-
diario detto broker: il mittente di
un messaggio si limita a “pub-
blicare” il proprio messaggio sul
broker; i destinatari si rivolgono
a loro volta al broker “abbonan-
dosi” alla ricezione di messaggi.
Quindi il broker inoltra ogni
messaggio inviato da un publi-
sher a tutti i subscriber interessati
a quel messaggio. Il meccanismo
di sottoscrizione consente ai
subscriber di precisare a quali
messaggi sono interessati tramite
un pattern (topic).

Pub/Sub disaccoppia un client
che sta inviando un particolare
messaggio da un altro client (o
molti clients), che sta ricevendo il
messaggio. Questo significa che

publisher e subscriber non cono-
scono 1'uno l'esistenza dell’altro.
Client e broker si scambiano mes-
saggi di polling per monitorare
lo stato delle comunicazioni; se il
broker non riceve una PINGREQ
o qualsiasi altro pacchetto da
uno specifico client, chiudera la
connessione e inviera 'ultimo
messaggio “will and testament”
(se il client ne ha specificato uno).
Il meccanismo di keep alive pud
essere disattivato.

IL FIRMWARE STIMA
Presentiamo ora le caratteristiche
generali del firmware utilizzato
nei moduli STIMA.

Stazioni fisse o mobili

E possibile installare stazioni sia
fisse (la cui posizione non cambia
nel tempo) che mobili, sia terre-
stri che marine; le stazioni sono
quelle che acquisiscono i para-
metri ambientali. Per aggiornare
le posizioni delle stazioni mobili
viene utilizzato un ricevitore
GPS, che puo essere 0 a bordo del
modulo Stima o quello integrato
in uno smartphone o in un tablet
basato su Android.

Differenti tipologie di rete

La configurazione della rete puo
essere differente a seconda delle
esigenze; oltre alla classica confi-
gurazione a stella (moduli master
e base) con un broker al centro,

e disponibile la configurazione
ad albero sia via cavo (modulo
master + base) che via radio: con
la possibilita di utilizzare moduli
radio di maggiore potenza (por-
tata di circa 1 km in aria libera) &
possibile prevedere coperture di
un territorio di ampia superficie.

Salvataggio locale dei dati

I dati possono essere pubblicati
in real time e/o salvati localmen-
te. E previsto un meccanismo di
salvataggio dei dati su SD-Card
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formattata FAT; i file vengono

frammentati con una dimensione

prefissata per farne circa uno al

giorno e numerati da 000 a 999; i

dati salvati prevedono un flag che

indica se sono stati gia pubblicati
correttamente su MQTT. I file

che devono essere controllati per

possibili reinvii hanno estensione

.que, mentre l'estensione di quelli

che hanno tutti i dati gia inviati e

.don. Con tali premesse si otten-

gono queste funzionalita:

* salvataggio dati su SD almeno
per due anni con campiona-
menti ogni 5 s (un parametro);

¢ reinvio automatico al server
dei dati salvati ma non pubbli-
cati correttamente sul server;

* ottimizzazione dei tempi, in
quanto solo i file che conten-
gono dati da inviare vengono
letti per selezionare i dati da
reinviare ;

¢ idati possono essere riletti su
un normale PC estraendo la
SD-Card.

Messaggistica di diagnostica

C’e la possibilita di ottenere
un’ampia messaggistica di diagno-
stica per la soluzione dei problemi;
attiva per impostazione predefini-
ta, puo essere disabilitata.

Configurazione

Le versioni delle configurazioni
vengono verificate e quando il
firmware non é retrocompatibile il
modulo resta in attesa di una nuo-
va configurazione. Si puo forzare la
configurazione tramite un apposito
ponticello sulla board Stima-12C.
Le configurazioni vengono subito
verificate: non e possibile configu-
rare un modulo con dei sensori non
corretti 0 non funzionanti.

Operazioni periodiche di
manutenzione

Il software effettua periodica-
mente tutte le funzioni di manu-
tenzione necessarie al corretto

funzionamento, quali quelle
relative al DHCP o alla sincroniz-
zazione dell’orologio interno con
una sorgente esterna, la gestione
dei pacchetti per la manutenzione
dei protocolli su TCP/IP o via
radio. Tutti i firmware hanno
attivo un watchdog hardware

che evita blocchi permanenti
dovuti a malfunzionamenti su
eventi improbabili; ogni 8 secondi,
quindi, il watchdog deve essere
reinizializzato per evitare un reset
del microcontrollore.

Orologio di riferimento

Quando e necessario salvare i
dati localmente (su SD-Card) e la
connessione utilizzata per pub-
blicare i dati sul server (broker)
non & considerata stabile, bisogna
disporre di una base dei tempi
precisa. Se invece la connessione
(trasporto) viene considerata sta-
bile (o non sia necessario recupe-
rare i dati in caso di guasto) un
preciso orologio di riferimento
non & necessario e il tempo di
riferimento verra aggiunto auto-
maticamente dal server in tempo
reale alla pubblicazione del dato.
Ci sono diversi sistemi per avere
un orologio di riferimento preciso
sui moduli Stima.

Crittografia

Qualora il trasporto non sia consi-
derato sicuro (via radio) viene uti-
lizzata la crittografia per garantire
riservatezza e autenticita.

Risparmio energetico

Nello sviluppo del firmware,
particolare attenzione e stata
posta alla limitazione dei consu-
mi: quando possibile, i microcon-
trollori e i sensori vengono messi
in sleep e sono alcuni interrupt

a risvegliare il sistema. Questo
agevola l'utilizzo con batterie dei
sistemi a basso consumo quali il
modulo Stima-satellite che fun-
ziona con un modulo radio.

Integrazione con la domotica

Per quello che & stato possibile,
nello sviluppo di STIMA si e cer-
cato di integrarsi con gli standard
della domotica (MQTT). Tutti i
moduli possono essere utilizzati
anche da attuatori on/off (fino a
quattro relé) ma e molto semplice
aggiungere altre funzionalita tra-
mite remote procedure in formato
json su tutti i trasporti o tramite
MQTT.

LIBRERIE

Analizzate le caratteristiche del
firmware, vediamo adesso le
librerie che esso utilizza e che in
parte abbiamo visto nella puntata
precedente.

aJson

Questo e un tentativo di portare
una completa implementazione
di JSON nell’ambiente Arduino;
la libreria & basata su ¢JSON,
ridotta di dimensione. Di JSON e
JSON-RPC abbiamo parlato nella
scorsa puntata in quanto tutte

le comunicazioni implementate
dal nostro firmware si basano su
tale standard. La libreria e stata
adattata per ridurre 1'uso della
memoria e implementare alcuni
tipi di dato non supportati.

JsonRPC

JsonRPC e la libreria che imple-
menta un sottoinsieme del proto-
collo JSON-RPC.

PubSubClient

Fornisce un client per semplici
publish/subscribe, scambiando
messaggi con un server che sup-
porta MQTT (broker); & adattata
per funzionare, oltre che con
I’ethernet, anche con GSM/GPRS.

Arduino_uip

Implementa le stesse API della
Arduino Ethernet library, ma
utilizzando I'ENC28J60 Microchip
come chip per la comunicazione
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ethernet. Oltre a creare un’imple-
mentazione completamente open,
infatti, questa libreria permette

di utilizzare 'ENC28J60, che &
molto pil1 economico dei chip con
stack IP incluso. Offre supporto
completo per le connessioni TCP e
UDP persistenti (streaming) (Client
e Server), ARP, ICMP, DHCP e
DNS. La libreria e stata sviluppata
da Norbert Truchsess derivandola
dallo stack ulP di Adam Dunkels.

RF24/RF24Network
OSI Network Layer ottimizzato
per moduli radio nRF24L01(+)
2,4GHz ISM. Abbiamo scelto
l'ultima versione elaborata da
TMRh20, che dalle nostre prove
e risultata la piui stabile e capace
di offrire piu1 opzioni, oltre che
di funzionare con Arduino e
Raspberry Pi. Supporta una topo-
logia di rete a stella o ad albero;
con il modulo da noi utilizzato si
possono coprire distanze di circa
50 metri in aria libera. Queste le
caratteristiche principali di fun-
zionamento: Host Addressing ogni
nodo ha un indirizzo logico nella
rete local; Message Forwarding i
messagi possono essere mandati
da un nodo a qualsiasi altro nodo
senza limite al numero di “salti”
che il messaggio deve fare; Ad-hoc
Joining un nodo pud entrare a
far parte della rete senza nessun
cambiamento alla configurazione
dei nodi gia esistenti. Per quanto
riguarda RF24Network indirizza-
mento e topology, a ogni nodo deve
essere assegnato dall’amministra-
tore un indirizzo a 15-bit. Questo
indirizzo descrive esattamente
la posizione del nodo all’interno
della rete ad albero. L'indirizzo
& un numero in formato ottale
dove ogni cifra rappresenta una
posizione all’'interno dell’albero,
partendo dalla base:
¢ Nodo 00 & il nodo base;
* Nodi 01-05 sono nodi il cui
genitore e la base;

* Nodo 021 ¢ il secondo figlio del
nodo 01;

e Nodo 0321 & il terzo figlio del
nodo 021, e cosi via.

L’indirizzo di nodo pii1 grande &
05555, cosi in teoria sono possibili

fino a 3,125 nodi in singolo canale.

sim800

Questa libreria e stata sviluppata

ex novo in quanto le funzionalita

di cui c’era bisogno non sono

disponibili in nessun’altra libreria

di gestione dei moduli GSM

SIM800/SIM900 della SIMCom.

La libreria implementa:

¢ protocollo TCP/IP transparent
mode con le API Etherlib;

¢ http in modalita nativa sim800;

* utilizzo dell'RTC interno alla
sim800.

Relativamente a, TCP/IP, una
volta che la connessione e stabili-
ta nella modalita trasparente, tutti
i dati ricevuti dalla porta seriale
saranno trattati per formare
pacchetti da essere poi trasmessi,
similarmente tutti i dati ricevuti
dal lato remoto saranno inviati
direttamente alla porta seriale.

SensorDriver

Libreria di “driver” per la gestio-
ne dei sensori; di essa esistono
attualmente due versioni: una in
C++ e una in python. La libreria
porta la gestione della sensori-
stica ad un livello di astrazione
piu alto. In essa, aggiungere un
nuovo tipo di sensore consiste
nell’estendere una classe con
quattro metodi per effettuare la
lettura di quello specifico sensore;
il comando:

int setup (int address);

effettua eventuali settaggi neces-

sari al funzionamento del sensore.

Ad esempio, per la temperatura
la sintassi &: numero di bit di

risoluzione, operazione di misura
one-shot. Il comando:

int prepare (unsigned long* waittime) ;

impartisce al sensore il comando
per effettuare una singola misura-
zione e ritorna il tempo in millise-
condi di attesa necessario.

Invece il comando:

int get (int* value) ;

ritorna i valori della misurazione.
Il comando:

adsonObject* getdson() ;

ritorna i valori misurati in forma-
to compatibile json.

Timel/TimeAlarms

Time fornisce un orologio
software che pud essere sincro-
nizzato con sorgenti esterne per
mantenerlo sempre preciso. Nel
nostro caso utilizziamo NTP se &
disponibile la rete ethernet, 'RTC
della scheda sim800 o 'RTC del
DS1307 tramite I2C. TimeAlarms
unitamente a Time esegue funzio-
ni a istanti di tempo specificati,
una-tantum o periodicamente.

SdFat

SdFat & una libreria per Arduino
che supporta FAT16 and FAT32
file systems su SD-Card standard
o ad alta capacita (SD/SDHC
Flash card). SdFat supporta la
creazione di file, cancellazione,
read, write, oltre al troncamento.
SdFat supporta anche I'accesso a
subdirectories, nonché la creazio-
ne e cancellazione di subdirecto-
ries. Supporta Long File Names e
usa la libreria Arduino SPI.

AESLib

Questa libreria implementa la
crittografia tramite AES per Ar-
duino; & un metodo per rendere
un messaggio “offuscato” in
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modo da non essere comprensi-
bile/intelligibile a persone non
autorizzate a leggerlo. Questo

e particolarmente importante
quando si utilizza un traspor-
to non sicuro quale quello via
radio. La crittografia, nel nostro
firmware e utilizzata per le
comunicazioni con nrf24, ma il
livello di sicurezza non & ancora
elevato e I'implementazione &
incompleta.

YwrobotLiquidCrystal_I2C

La libreria per la gestione del
display LCD tramite I2C-Bus
possiede tutte le funzioni pre-
senti nella libreria di sistema
“LiquidCrystal”. Inoltre supporta
gran parte delle funzioni lista-

te nella specifica ufficiale per i
display LCD.

IL FILE DI CONFIGURAZIONE

A TEMPO DI COMPILAZIONE

Il firmware STIMA fa un uso
intensivo delle direttive del pre-
processore C; definendo delle va-
riabili e possibile ottenere da un

unico codice diversi firmware per

i vari moduli. Il file rmap_config.h
situato in sketchbook/rmap/rmap
comanda quasi tutte le opzioni e
le configurazioni hardware; con-
tiene i template da utilizzare per
ottenere i firmware per i moduli
qui presentati. Non riuscendo, in
queste pagine, ad analizzare in
modo completo tutto il firmware,
ci limitiamo a evidenziare le
funzioni principali contenute in
sketchbook/rmap/rmap/rmap.ino.
Nel main loop troviamo:

» mgrserialjsonrpc; provvede alla
gestione della porta seriale per
jsonrpc;

» mgrrf24jsonrpc; provvede alla
gestione della comunicazione
radio e jsonrpc;

* mgrmqtt; esegue la gestione del
protocollo MQTT e jsonrpc;

» mgrethserver; gestisce il server

tep/ip per jsonrpc.

La funzione mgrjsonrpc ¢ la
funzione utilizzata per gestire il
protocollo json-RPC. Se il modulo
e attivo periodicamente viene
eseguita la funzione Repeats, che
svolge le operazioni di interroga-
zione dei sensori e pubblicazione
dei dati.

LHARDWARE DEL PROGETTO

E giunto il momento di descrive-
re le tre configurazioni proposte
in modo da spiegare che tipo di
misura possono eseguire e quale
connettivita possono supportare.
Ogni modulo consta di una sche-
da Microduino e di alcuni shield
per essa.

MODULO STIMA MASTER
Questo modulo e ideale per gli
appassionati di meteorologia
che sognano una stazione meteo
fissa, con sensori locali e remoti
collegati sia con cavo che via ra-
dio. Il Modulo Stima Master puo
essere dotato di display LCD
per il controllo dello stato del
sistema e trasmette i dati tramite
ethernet al server RMAP. Vedia-
mo da quali board & composto.

Board microduino core+ 1284
La board core+ 1284 & molto
simile al modello core+ 644
che abbiamo visto nello
scorso numero, solo che
e piu1 prestante; I’ab-
biamo scelta perché
il Modulo STIMA
Master ha bisogno
di un microcontrol-
lore dotato di molta
memoria Flash e SRAM per
le diverse funzioni che svolge.
Sulla board, che rappresenta

il modello piu evoluto fra le
Microduino core, il componen-
te principale e I’Atmegal284P
funzionante a 16 MHz, dotato
di 128 K di memoria Flash e 16
K di SRAM. Il firmware che vi
carichiamo & molto articolato

perché gestisce comunicazioni
via LAN e via radio, nonché tutti
i protocolli R-map.

Board microduino ENC
Permette di collegare alla rete ca-
blata il modulo Stima Master; e
ancora uno shield Microduino, o
meglio, una coppia: una scheda
che alloggia il connettore RJ45 e
lo stabilizzatore switching per il
PoE, ed una seconda sulla quale
si trova l'integrato ENC28]J60,
compatibile con lo standard
IEEE 802.3. Questo integrato
prodotto da Microchip integra
entrambe le funzioni MAC e
10BASE-T PHY e permette una
gestione semplificata per il mi-
crocontrollore di tutto lo stack di
comunicazione Ethernet; anche
questa board dialoga tramite la
porta SPL.

Microduino ENC ha anche una
caratteristica molto interessante,
permette ’alimentazione della
board e delle altre schede in
modalita PoE.

Utilizzando un apposito adat-
tatore (ad esempio quello

STIMA Master al completo.

-
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commercializzato dalla Fu-

tura Elettronica con il codice
7300-SETCAVIPOE) ed un
alimentatore da 12 a 24 volt (a
seconda della distanza del colle-
gamento) possiamo alimentare
il modulo tramite un solo cavo,
usato sia per la comunicazione
Ethernet che per I’alimentazione
del modulo. Cib facilita notevol-
mente i cablaggi.

Board STIMA-I12C

Questa board 1'abbiamo vista
nella prima puntata ed & uti-
lizzata da tutti i moduli; ha
diverse funzioni: genera 3,3 volt
per l'alimentazione, protegge i
componenti da scariche elettro-
statiche ed espone il bus 12C per il
collegamento dei sensori con un
comodo connettore.

Board microduino nRF24 (opzio-
nale)

Questa board, che e opzionale, e
prodotta da Microduino e pro-
gettata per comunicare via radio
in banda ISM alla frequenza di
2,4 GHz. Componente principale
della scheda ¢ il diffusissimo
integrato nrf2401+ prodotto

da Nordic Semiconductor, che
permette comunicazioni radio
fino a qualche decina di
metri di distanza in
campo aperto. La
board permette la
ricezione dei dati

da moduli STIMA
Satellite, oltre che

da sensori remoti che
possiamo collocare sul
terrazzo o in punti

non collegabili con
cavo.

Sulla scheda e previ-
sto un connettore SMA
cui collegare un’anten-
na fornita in dotazione
al modulo o una a nostra
scelta, essendovi un attacco di
tipo standard.

MODULO STIMA-SATELLITE

Si tratta di un’unita, composta
al solito da piu1 schede, che & di
tipo “passivo” in quanto rimane
in attesa di richieste via radio da
un modulo STIMA Master o da
uno STIMA-GSM/GPRS; all’ar-
rivo di una richiesta, il modulo
interroga i sensori collegati via
12C-Bus e ne trasmette le mi-
surazioni al modulo Master. 11
modulo STIMA Satellite si puo
utilizzare nel sistema solo se sul
modulo STIMA Master o GSM/
GPRS avete montato la board
Microduino nRF24.

Lo STIMA Satellite & composto,
oltre che da Board STIMA-12C
(per la quale vale quanto gia det-
to nel modulo Master) e da una
board microduino nRF24, da una
Microduino core+ 644 che ne
costituisce il cervello.

La board nRF24 gestisce i sen-
sori e le comunicazioni radio. E
possibile utilizzare pitt moduli
Stima-satellite: fino a cinque che
comunicano direttamente con

lo STIMA Master, piu1 eventuali

STIMA Satellite al
completo.

altri disposti in una configura-
zione ad albero. E necessaria
un’opportuna configurazione,
ma in questo caso la possibilita
di far fare ai dati “salti multipli”
rende possibile 1'uso di questi
sensori in campo aperto su
medie distanze, alimentando il
modulo con batterie.

Board microduino core+ 644
Trattandosi di un modulo con
funzionalita meno articolate del
modulo Master, la board core+
644 ¢ sufficiente per eseguire le
funzioni richieste, perché ha un
firmware di dimensioni contenu-
te se non si utilizza la crittografia
o altre estensioni software.

MODULO STIMA GSM/GPRS
Abbiamo analizzato il modulo
Stima-Master, che comunica
con il server RMAP attraverso
rete cablata, ma per utilizzare
il sistema STIMA in zone senza
connessione ethernet e possibile
utilizzare questo modulo con
la rete di telefonia mobile.
Vista la minore stabilita
di questa rete di
comunicazione, il
modulo & in grado
di salvare permanen-
temente i dati per un lun-
go periodo su una SD-Card.
STIMA GSM/GPRS & simile
al Master per quanto riguarda
la scheda Arduino (e infatti
basato su una board Micro-
duino core+1284, scelto
per eseguire ed ospitare il
firmware, che & complesso
e pesante) e puo disporre,
in opzione, di una board
microduino nRF24 laddove
sia necessario aggiungere
sensori remoti collegati via
radio. Infatti lo STIMA GSM/
GPRS nasce per essere usato
in zone isolate, dove i sensori
debbono essere montati su pali o
a decine di metri di distanza con
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cablaggi
non sem-
pre semplici.
Oltre che da
quanto appena
descritto, il modulo
STIMA GSM/GPRS

e composto da una board
STIMA-I2C dagli shield seguenti.

Board microduino GPRS/GSM
Basato sul SIM800, un modulo
quad-band GSM/GPRS, lavora
sulle bande di frequenza GSM
850 MHz, EGSM 900 MHz, DCS
1.800 MHz e PCS 1.900 MHz. 11
SIM800 & un GPRS multi-slot
class 12/class 10 e supporta gli
schemi di codifica GPRS CS-1,
CS-2, CS-3 e CS-4. Per gestirlo si
utilizzano comandi AT impartiti
via seriale con un data-rate che
pud variare tra 1.200 e 115.200
bps. Il transfer-rate della comu-
nicazione su GPRS e di 85,6 kbps
sia in uplink che in downlink.

Board microduino SD

Per ridurre i costi di connessione
o evitare perdite di dati in caso
di mancata connessione al ser-
ver, il modulo memorizza i dati
su SD-Card, che nello specifico &
nel formato microSD.

Quando la connessione al server
viene ristabilita, i dati vengono
inviati alla destinazione prevista.
La memorizzazione dati su SD
consente di salvare dati cam-
pionati ogni 5 secondi per un
periodo massimo di due anni.

Modulo STIM GSM/GPRS completo di

sezione RF opzionale.

ACCESSORI

Vediamo ora alcuni accessori
con cui e possibile estendere le
funzionalita dei tre moduli.

LCD display

Un display Hitachi 4x20 caratteri
ad interfaccia I’C-Bus puo essere
collegato a tutti i moduli per
visualizzare lo stato di funziona-

mento, la connessione al server,
l'ora e i dati rilevati, permettendo
una diagnostica immediata.

Relé

Siccome il sistema STIMA &
predisposto per la domotica,
sulla board Stima-12C si trova un
connettore pronto per collegare
moduli da uno a quattro relé
pilotabili con JsonRPC.

Dato che la scheda equipaggia
tutti e tre i moduli, ogni modulo
puo pilotare degli attuatori.

Sensori

L’ampia possibilita di collega-
mento dei sensori sul bus I2C
verra esaminata nella prossima
puntata; per ora utilizziamo per
i test il sensore di temperatura
incluso sulla board STIMA-12C.

COMPILAZIONE E
INSTALLAZIONE DEL FIRMWARE
Passiamo adesso al firmware,
installando per prima cosa I'IDE

01 [ _
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® oo il Br:
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Fig. 1 - Le piazzole SET sono dal lato
saldature della board STIMA-I2C.

Arduino 1.6.5 da https://www.ardu-
ino.cc/en/Main/Software.

Scaricate 'ultima versione

del software stima (file stima-
sketchbook) da https://github.
com/r-map/rmap/releases e scom-
pattate il file zip stando attenti

a ignorare i file “Source code”.
Aprite I'IDE Arduino e in File-
>Impostazioni disabilitate “Con-
trolla aggiornamenti all’avvio”
poi in File->Impostazioni->Percorso
della cartella degli sketch seleziona-
te la cartella sketchbook appena
scompattata dal file scaricato

e chiudete e riaprite 'IDE. In
questo modo, quando compilere-
te il firmware utilizzerete alcune
opzioni specializzate contenute
nel file sketchbook/hardware/Micro-
duino/avr/platform.local.txt, neces-
sarie per ottenere un firmware
funzionante.

Per quanto riguarda il modulo
Stima-master, se in esso avete
montato anche la board microdui-
no nRF24 e quindi volete utilizza-
re anche il modulo Stima-Satellite,
con un editor modificate il file
sketchbook/libraries/SensorDriver/
SensorDriver_config.h decom-
mentando 'opzione “#define
RADIORF24” ; decommentando
anche l'opzione #define AES
abiliterete anche la crittografia
AES, tuttavia consigliamo 1'u-
tilizzo di quest’ultima opzione
solo ai piu esperti. In sketchbook/
rmap/rmap dovete copiare il file
stima_master.h in rmap_config.h.
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" Listat

rmapctrl --syncdb

rmap-configure --station_ slug=ETH_fixed --board slug=master_ eth fi-

xed --height=<altezza stazione in metri> --stationname="<descrizione
della stazione>” --username=<il vostro utente> --password=<la vostra
password> --server=rmap.cc --samplerate=5 --lat=<latitudine stazione>

--lon=<longitudine stazione> --addsensors_by template=<sensortemplate> :

--wizard --config station --upload to_server

Poi andate nel menu Strumenti

e nella voce Scheda seleziona-

te Microduino Core+ (1284pa);

nella voce Processore scegliete

ATmegal284pa@16M5V e in Por-

ta impostate la COM disponibile.

Adesso, impartite il comando

Strumenti->Cartella degli sketch-

>rmap->rmap; infine, impartite il

comando Sketch->Carica.

Passiamo adesso alla configu-

razione per il modulo STIMA

Satellite: in sketchbook/rmap/rmap

copiate il file stima_satellite.h in

rmap_config.h. A questo punto dal

menu Strumenti scegliete:

o Scheda: Microduino Core+
(644pa);

® Processore:
ATmega644pa@16M5V;

* Porta: quella disponibile.

Impartite quindi il comando
Strumenti->Cartella degli sketch-
>rmap->rmap e poi Sketch->Carica.
Concludiamo con la configu-
razione per il modulo STIMA
GSM/GPRS: in sketchbook/rmap/
rmap copiare il file stima_gsm.h in
rmap_config.h; il file & predisposto
per l'utilizzo di una SIM-Card
della TIM. Laddove ne utilizziate
una di diverso operatore, inserite
in fondo al file rmap_config.h:

#define GSMAPN “”
#define GSMUSER “”
#define GSMPASSWORD “”

scrivendo in GSMAPN I’APN
fornito dal vostro operatore, in
GSMUSER lo username con cui
accedete a Internet e in GSMPAS-
SWORD la password per 'acces-
so. Salvate quindi il file.

Ora aprite il file accessibile da

sketchbook/libraries/PubSubClient/
PubSubClient.h e modificate:

//if use sim800 client
#include “sim800Client.h”
#define TCPCLIENT sim800Client

con questa porzione di codice:

//1if use arduino_uip or etherclient
//#include “Client.h”

//#include “Stream.h”

//#define TCPCLIENT Client

Nel menu Strumenti scegliete:

® Scheda: Microduino Core+
(1284pa);

® Processore:
ATmegal284pa@16M5V;

® Porta: quella disponibile.

Sempre in Strumenti, impartite
il comando Cartella degli sketch-
>rmap->rmap. Infine, impartite il
comando Sketch->Carica.

CONFIGURAZIONE

Per configurare le board dovete
utilizzare 1’applicazione grafica
o 'utilita a linea di comando.
Come avere il software installato
sul proprio computer lo abbiamo
spiegato nella scorsa puntata, ma
le istruzioni si possono anche

recuperare sul web da http://www.

raspibo.org/wiki/index.php/Grup-
po_Meteo/HowTo.

Poi per pubblicare i dati sul ser-
ver RMAP.cc bisogna registrarsi
al sito; il pulsante “Registrazio-
ne” dell’app dovrebbe aprire un
browser alla url della registrazio-
ne (http://rmap.cc/registrazione/re-
gister/). Una volta fatta la registra-
zione sarete in possesso di uno
user e di una password.

A questo punto dovrete trasferire

la vostra configurazione sulla

EEPROM del microcontrollore e

allo scopo:

* ponticellate sulla board Stima-
12C le piazzole “SET” (Fig. 1) .

¢ collegate il modulo con la bo-
ard Microduino FI232RL alla
USB del vostro PC.

Configurazione tramite
I'applicazione grafica
Aprite I'applicazione grafica e dal
menu Impostazioni che si aprira
automaticamente al primo avvio,
nella sezione “Rmap” dovrete
inserire “RMAP user” e “RMAP
password” ottenuti durante la regi-
strazione a rmap.cc.
Adesso, dal menu Impostazioni
selezionate la sezione “Sensors” e
impostate:
e per il modulo Stima-Bluetooth:
o Name: HC-05;
o Station: BT_fixed;
o Board:
- su android: BT_fixed;
- sulinux: BT_fixed_LINUX;
- su windows: BT _fixed_
WINDOWS;
- su OSX: BT_fixed_OSX.
o Template: test_indirect;
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o Remote Board: stima_bt;
o Remote Template: test ;
* per il modulo Stima-Master o

Stima-GSM/GPRS:

o Station: ETH._ fixed;

o Board:
- su linux: rmapgui_LINUX;
- su windows: rmapgui_

WINDOWS;

- su OSX: rmapgui_OSX.

o Template: test_indirect;

o Remote Board: master_eth_
fixed;

o Remote Template: test (test_
master se avete la board
nREF24).

Per il modulo Stima-Satellite fate
come per lo Stima-Master, ma in
Remote Board scegliete satellite_
eth_fixed. Nella sezione “Location”
potete inserire manualmente le
vostre coordinate e selezionare
“Close” attivando cosi la stazione.
Se non conoscete le vostre coordi-
nate, dalla pagina “Posizione” se-
lezionate accuratamente la vostra
posizione con il mouse e salvatela
con il pulsante “Salva posizione”
(Fig. 2). La prima pagina dell’App
“Avvia” presenta un manuale che
potra aiutarvi.
Dalla pagina “Dati automatici”
fate clic sul pulsante “configura”
e verificate che tutto vada a buon
fine.

Configurazione

a linea di comando

E possibile eseguire tutte le
configurazioni con due coman-
di da terminale: da Windows
utilizzate la finestra che rimane
aperta dopo aver eseguito rmap-
configure.bat; su Linux o OSX
attivate il Virtualenv di python
come per eseguire I’App grafica.
Il primo comando inizializza il
DB. Il secondo, con l'opzione
--wizard inserisce tutti i metadati
nel DB, --config_station trasfe-
risce la configurazione sulla
EEPROMdel microcontrollore

e ——upload_to_server comunica i
metadati al server (Listato 1).
Ovviamente sostituite il contenu-
to tra <> con i vostri dati; cercate
di avere latitudine e longitudine
definite fino alla quinta cifra de-
cimale; <sensortemplate> dovra
essere “test_master” se il vostro
modulo Stima-master o Stima-
GSM/GPRS comprende una
board microduino nRF24, “test”
in tutti gli altri casi.

Operazioni finali

Scollegate il modulo dalla USB,
rimuovete la board Microduino
FT232RL e attivate 1’alimentazio-
ne a 3,3V chiudendo il ponticello
JP2 della board Stima-I12C.

MESSA IN OPERA

Sul modulo Stima-GSM/GPRS
inserite una micro SD format-
tata FAT; dovete inserire anche
una SIM-Card. Alimentate i
moduli tramite il connettore
micro-USB sulla board Stima-
12C; il modulo Stima Master
potete alimentarlo con ’apposito
Injector e un alimentatore da 12
a 24V (connettore con positivo
al centro). Sul modulo Stima-
GSM/GPRS il SIM800 va acceso
manualmente tenendo premuto
I'apposito switch. Sulla rete
ethernet dovrete avere un server
DHCP in quanto STIMA Master
lo richiede. Se tutto funziona
regolarmente, ogni 5 secondi i
dati della temperatura di test
del modulo verranno inviati a
rmap.cc. A questo punto se sul
server rmap.cc fate login con il
vostro nome utente, accederete
alla vostra pagina personale con
'elenco delle stazioni di misura
e la possibilita di visualizzare i
grafici (Fig. 3) dei vostri dati. Per
ora potete inviare solo i dati di
test (temperatura del modulo);
nella prossima puntata vedrete
come aggiungere sensori per la
visualizzazione dei dati.
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WE* per il MATERIALE

Tutti i componenti utilizzati in questo

progetto sono di facile reperibilita.

| master dei circuiti stampati posso-

no essere scaricati dal sito della rivi-

sta. | componenti elencati di seguito
si possono acquistare presso Futura

Elettronica:

*Microduino Core ATMEGA1284
(cod. MDUINO1284) a Euro 22,00.

*Microduino Core+ ATMEGAG44PA
(cod. MDUINOCORE+) a Euro 15,50.

*Microduino  Shield USB/TTL
(cod. MDUINOUSBTTL) a Euro 19,00.

*Microduino Shield SDcard
(cod. MDUINOSD) a Euro 12,50.

*Microduino Shield NRF24
(cod. MDUINONRF24) a Euro 16,00.

*SET CAVI POE (cod. SETCAVIPOE)
a Euro 6,00.

*Display LCD 20x4 con interfaccia
12C (cod. LCD20X4AI2C) a Euro
26,00.

*MODULO 4 RELE 5VDC 10A
(cod. RELAY4CH) a Euro 13,00.

*MODULO 2 RELE 5 VDC 10A
(cod. RELAY2CH) a Euro 8,00.

*Modulo 1 relé 5 Vdc 10A
(cod. RELAY1CH) a Euro 5,00.

Tutti i prezzi si intendono IVA com-

presa.
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